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About MicroHelp

You can get in touch with MicroHelp at the following address:

MicroHelp, Inc.
4359 Shallowford Industrial Parkway
Marietta, GA    30066

Sales: (800) 922-3383
Fax: (404) 516-1099
Technical support: (404) 516-0898
BBS: (404) 516-1877

Hours:    Monday through Friday, 9:00 AM to 5:00 PM, Eastern Time

See also:
About UnInstaller



About MicroHelp UnInstaller

MicroHelp UnInstaller
Version 1.0

By Ken Spreitzer
Copyright © 1992, MicroHelp, Inc.
All rights reserved

UnInstaller is a trademark of MicroHelp, Inc.    SmartDecoy is a trademark of Maximized 
Software.    Other names are trademarks or registered trademarks of their respective owners.

See also:
About MicroHelp



Confirm

UnInstaller uses this window to confirmation deletion of a file or a WIN.INI section.

Review the detailed description of the item and then decide whether you want to delete the file.

Note
If you have SmartLinks turned on, and UnInstaller is confirming the deletion of a program file, a list box
displays other programs which also use the file being deleted.    If other programs are listed, then 
deleting the file will probably prevent the other programs from working.

To delete the file or section
1 Choose the Yes button.

To delete the file or section and turn off confirmation
1 Choose the "Yes to all" button.    This causes UnInstaller to delete the specified file or 

section and turn off confirmation for most of the remaining items.    Choosing "Yes to all" 
is equivalent to clearing the Confirm all deletions checkbox on the main UnInstaller 
window.    You will be prompted for confirmation before deleting selected items, such as 
Program Manager icons.

To not delete the file or section
1 Choose the No button.    The file or section will not be deleted.

To view the file or section before deleting it
1 Choose the View button.    The file or section will be displayed in the viewer.
2 When you are done viewing the file or section, choose the viewer's Close button to 

close the viewer.



Confirm all deletions

This checkbox controls whether you are prompted for confirmation before most items are deleted.    
When this checkbox is checked, you are prompted to confirm all deletions.    If you leave the box 
unchecked, you will not be prompted to confirm the deletion of most items, but a few selected items 
always require confirmation.

See help for each item to see if it will be affected by the state of the "Confirm all deletions" checkbox.



Decoy

The term decoy is used interchangeably with the term SmartDecoy.



Delete all files

This window is used for two purposes:    to delete all files having a given extension from your local 
(non-network) hard disk(s) and to delete all remaining files from a program's directory.

UnInstaller scans your hard disk(s) for the appropriate files and displays the file names in the list box 
of this window.    Select the files you want to delete and then choose the Delete button.

To select files for deletion
1 For each file listed, either select it or deselect it.    By default, all files are deselected.    

Clicking on a filename with the mouse (or using the spacebar while the focus outline is 
on the desired file) alternately selects and deselects.

To view a file prior to deleting it
1 Put the focus outline onto the name of the file that you wish to view.    You can do this by

either selecting or deselecting the filename.
2 Choose the View button.    This action displays the file in the viewer.
3 When you are finished viewing the file, choose the viewer's Close button to close the 

viewer.

To delete files
1 Select the files that you would like to delete (see the procedure above).
2 Choose the Delete button.

You will be given one prompt to warn you that all of the selected files will be deleted at 
once.    You will not be able to confirm each selected file individually.

3 Choose OK to confirm the deletion of the files, or choose Cancel if you do not want to 
delete all of the selected files.

4 When the selected files have been deleted they will be removed from the list.    You may
then select more files for deletion.

To close the window without deleting any files
1 Choose the Close button.    The window will close without deleting any more files, even 

if some files are selected in the list.



DLL

A DLL (Dynamic Link Library) is a special file that programs use when they are executing.    DLL files 
are used in conjunction with a program's main program file, which usually has a file extension of EXE.  
Some DLL files are used by only one program, while others are used by many programs.

When you uninstall a program from your system, you should also remove the program's associated 
DLL file(s).    However, if another program (in addition to the one you are uninstalling) uses the same 
DLL file(s), then you shouldn't delete the DLL's. The reason is that doing so would prevent the other 
programs from executing correctly.

UnInstaller's SmartLinks feature can scan your system to determine which programs use which DLLs.  
This helps UnInstaller give you better advice about which DLLs should be deleted.

Most DLLs have a file extension of DLL, but some have an extension of VBX.    Other extensions are 
very uncommon.



Exit

Choose the Exit button or choose Exit from the File menu to immediately exit UnInstaller.



File menu

The file menu contains the following options:

Select a program to uninstall...
SmartLinks sub menu

On
Off
Full scan...

Uninstall SmartDecoy...
Exit



Full scan

For most installations, you only need to choose On from the File / SmartLinks sub menu in order to 
activate SmartLinks.    You may choose Full scan to re-scan your system, but it is not necessary.

A full scan may take several minutes.

Technical note
SmartLinks data is stored in a file named UNINSTAL.DAT in your Windows directory.    Turning on 
SmartLinks with the File / SmartLinks / On menu item reads the contents of the prior SmartLinks scan 
from UNINSTAL.DAT and then searches for any new files.    The updated list of SmartLinks is stored 
back into UNINSTAL.DAT.

Performing a full scan deletes your current UNINSTAL.DAT file, then performs a normal update scan.



Glossary

Choose any of the following terms to display their definition:

Decoy

DLL

SmartDecoy

SmartLinks



Help menu

There are several options on the Help menu:

Current selection
Choosing this option calls up help about the current topic.    If you are in the main window and the 
focus is in the Items to be deleted list box, you will get help specific to the item that has the focus.

Shortcut: Press <F1>

Index
The Index option calls up this help file and displays the help index.

Glossary
Choosing this option displays the help glossary.

Technical Support
This option displays a help topic which has the telephone number for MicroHelp's technical support.    
This phone number can also be obtained by choosing the About option from the Help menu.

About...
Displays information about UnInstaller.



Introduction to UnInstaller

UnInstaller is a Windows utility which makes it easy to remove a program from your system.

Prior to UnInstaller, if you wanted to remove a program from your system, you had to manually find 
and delete all of the files that the program used.    You also had to delete all references to the program 
from your WIN.INI file, and delete the program's icons in Program Manager.    UnInstaller does all this 
-- and more! -- automatically.

SmartDecoy
UnInstaller provides SmartDecoy technology, which can automatically clean the system for each user 
on a network.    Using UnInstaller's unique SmartDecoy technology, network administrators can save 
hours of time and effort that would otherwise be required to clean up each user's system on an 
individual basis.

SmartLinks
UnInstaller's SmartLinks feature can analyze the programs on your system to determine which 
programs use which DLLs.    This information is then used to determine which DLLs should be deleted 
when uninstalling a program.    In addition, if multiple programs share the same DLL, UnInstaller will tell
you so!

See also:
Quick instructions



Items to be deleted

When you select a program to uninstall, UnInstaller analyzes your system to find all traces of the 
program.    Everything related to the target program is listed in the "Items to be deleted" list box.    You 
select (highlight) the items you want to delete; items that are not selected will not be deleted.

To select or deselect an item using the mouse
1 Click on the item.

Each successive click on an item selects or deselects the item.

To select or deselect an item using the keyboard
1 Press <Tab> to move the focus to the "Items to be deleted" list box.
2 Use the up and down arrow keys to move to the desired item line.
3 Press the <spacebar>.

Each successive press of the <spacebar> selects or deselects the item.

These buttons are used to simultaneously change the selected state of all items in the list box.

All
The All button selects all items in the list.

0
The 0 button deselects all items in the list.

+/-
This button toggles the selection of each item in the list:    selected items become deselected, and 
deselected items become selected.

Default
The Default button restores each line to its default select state.    UnInstaller provides a default select 
state for each item:    most items are selected by default, but some items are deselected.    If you 
change the selection of some items and then want to restore the default selection state, use the 
Default button.

Note
You cannot move to these buttons using the Tab key.    Instead, hold down the <Alt> key and press the 
underlined letter or character in the button.    Then release the <Alt> key.    For example, to choose the 
0 button, press <Alt>+<0> (number zero, not letter Oh).    To choose the +/- button, press <Alt>+<+> (+
is created by Shift+=).

See also:
All files with extension "  ext  " on local drives (individually selectable)  
Association "  ext=Program.EXE  " from WIN.INI and system registration database  
Delete all other files in   directory   and its subdirectories (individually selectable)  
DLL   filename.ext   (is used by other programs)  



DLL   filename.ext   (may be used by other programs)  
Extension '  ext  ' from DOCUMENTS= line of WIN.INI  
File: '  filename.ext  '  
Help file in program directory:   filename  .HLP  
Help file in Windows directory:   filename  .HLP  
Help file in System directory:   filename  .HLP  
Help annotation file:   filename  .ANN  
INI file in program directory:   filename  .INI  
INI file in Windows directory:   filename  .INI  
INI file in System directory:   filename  .INI  
Main program:   filename.ext  
OLE object type '  Object name  '  
Program '  Program  ' from LOAD= line of WIN.INI  
Program '  Program  ' from RUN= line of WIN.INI  
Program Manager icons referencing '  Program  ' (with individual confirmation)  
Program Manager icons with extension '  ext  ' (with individual confirmation)  
Remove   directory   (and subdirectories) if empty when done  
Section [  SectionName  ] of WIN.INI  
Section [SPOOLER] of WIN.INI
Set 'SPOOLER=NO' in WIN.INI
Select this line to create a SmartDecoy
Select this line to create an uninstall report



Main window

UnInstaller's main window contains the following objects:

File menu
Help menu
Select button (calls up a window)
Uninstall button
Report setup button (calls up a window)
Add file button (calls up a window)
Add section button (calls up a window)
Exit button
Confirm all deletions checkbox
Items to be deleted list box

To get help on any item listed in the "Items to be deleted" list box:    
1 Click on the item with the mouse or press <Tab> until the focus is on the list box and 

use the arrow keys to move to the desired line
2 Press <F1>.    

Be aware that if you click on the item with the mouse, you will need to click on it again to restore its 
selected state.

See also:
Index



Off

Choose Off from the File / SmartLinks sub menu to turn SmartLinks off.

When the SmartLinks feature is turned off, a checkmark appears next to the Off menu option.



On

Choose On from the File / SmartLinks sub menu to turnSmartLinks on .

When the SmartLinks feature is turned on, a checkmark appears next to the On menu option.



Quick instructions

Main procedure
1 Turn on the SmartLinks feature if you want to use it.

2 Choose the Select button and then choose a program to uninstall.
UnInstaller will analyze your system to find all traces of the program.

3 Review the list of items that UnInstaller has found.    Only those items which are 
selected (highlighted) will be deleted by UnInstaller;    deselected items will not be
deleted.    By default, some items will selected and some items will not be selected.    If 
you are unsure of what the items mean, then you should just accept the default 
selections.    If you are sure of what the items mean, you can select or deselect items for
deletion.

4 Choose the Add file or Add section button to add a file or WIN.INI section to the list of 
items to be deleted.

5 Select or deselect the first line in the list box in order to enable or disable printing an 
uninstall report.    Choose the Report setup button if you want to change the uninstall 
report setup.

6 Place a checkmark in the Confirm all deletions checkbox if you want to be confirmed 
before deleting each item.    Remove the check if you do not want to be prompted for 
confirmation before deletion of most items.

7 Choose the Uninstall button to begin the uninstall procedure.



Report setup

Use this dialog box to configure the uninstall report.    You can use this dialog box to specify what file (if
any) the report should be written to and what printer (if any) the report should be sent to.

Note
This dialog box appears only if the first line in the list of items to be deleted ("Select this line to create 
an uninstall report") is selected and you also choose the Report setup button.

To turn reporting off
1 Close the Report setup window if it is currently open.
2 Deselect the first line in the list of items to be deleted ("Select this line to create an 

uninstall report").

To turn reporting on
1 Make sure that the first line in the list of items to be deleted ("Select this line to create 

an uninstall report") is selected.
2 Choose the Report setup button to display the Report setup window.    Set output 

options in this window as explained below and then choose OK.

To write the report to a file
1 Make sure that the first line in the list of items to be deleted (Select this line to create an 

uninstall report) is selected, and then choose the Report setup button.
2 Place a checkmark in the "Output to file" checkbox.
3 Select a filename for the report.    By default, the report will be written to a file named 

UNINSTAL.TXT in your Windows directory.    This should be fine for most users.    If you 
would like the report to be written to a different file, choose the Select file button to 
specify a different filename.

4 Select the output method:

Select "Add to end of file" (default) if you would like the report to be added to the end of 
the specified file.    This is the safest option because it will not destroy the contents of an
existing file.

Select "Overwrite file" if you would like the report to overwrite the contents of an existing
report file.    This causes you to lose any data already in the existing file.    (UnInstaller 
will prompt you before it overwrites the file.)

To print the report to a printer
1 Make sure that the first line in the list of items to be deleted (Select this line to create an 

uninstall report) is selected, and then choose the "Report setup" button.
2 Place a checkmark in the "Print report" checkbox.
3 Select a printer for the report.    The default printer name is displayed under the "Print 

report" checkbox.    If you would like the report to be printed on a different printer, 
choose the "Print setup" button.



Select a program

This window is used to select the program that you want uninstall.

UnInstaller will scan your Program Manager groups and present you with a list of all programs installed
into Program Manager.    The programs are displayed by group, just as in Program Manager.    You can 
select a program from this list, or you may use the Browse button to manually locate a program.

Once you have selected the program you want to uninstall, choose the Analyze button.    UnInstaller 
will analyze your system to find all traces left by the selected program.    UnInstaller will not delete 
anything until you later choose the Uninstall button in the main window.

To select a program from a Program Manager group
1 Select the program from the list.    The program's description and icon, if available, will 

be displayed under the list.
2 Choose the Analyze button.

To select a program not listed
1 Choose the Browse button.    A window will open.
2 Use the window to locate the program you want to uninstall.
3 Choose the Analyze button.

To select a program already deleted from your system
1 Choose the Browse button.    A window will open.
2 Type the program's filename into the Filename field of the dialog box.    For example, 

enter APPNAME.EXE and then choose OK.    Don't worry about the fact that the file 
does not actually exist in the directory specified.

3 Choose the Analyze button.



Select a WIN.INI section to be deleted

Use this dialog box to specify an additional section of your WIN.INI file to be deleted by UnInstaller.

To select a WIN.INI section to be deleted
1 Select the section name in the list.
2 Choose the View button if you would like to review the contents of the section.    When 

you are done viewing the section, choose the Viewer's Close button to close the viewer.
3 Choose the OK button to add the selected section to the list of items to be deleted.



Select an additional file to be deleted

Use this dialog box to select an additional file to be deleted by UnInstaller.    The selected file is added 
to the list of items to be deleted.

To select a file to be deleted
1 Select the appropriate drive in the Drives drop-down list.
2 Select the appropriate directory in the Directories list box.    Always remember to double-

click (or press <Enter>) in this list box!
3 Select the desired file in the Files list box.
4 Choose the OK button.



Select the program to be uninstalled (manually)

Use this dialog box to manually select the filename of the program that you would like to uninstall.

To select a program filename
1 Select the appropriate drive in the Drives drop-down list.
2 Select the appropriate directory in the Directories list box.    Always remember to double-

click (or press <Enter>) in this list box!
3 Select the desired file in the Files list box.
4 Choose the OK button.

To select a program already deleted from your system
1 Type the program's filename into the Filename field of the dialog box.    For example, 

enter APPNAME.EXE and then choose OK.    Don't worry about the fact that the file 
does not actually exist in the specified directory.

2 Choose the OK button.



SmartDecoy definition

SmartDecoys are an advanced feature of UnInstaller.    They are used to ease the uninstall process for 
multiple users on a network.

A SmartDecoy is a copy of the UnInstaller written over the original program.    When any user on the 
network tries to run the program, they actually run the decoy.    This decoy copy of UnInstaller offers to 
clean up the user's system.



SmartDecoy

When you uninstall a program, UnInstaller can leave a "decoy" copy of itself renamed as the original 
program name. When other users run the decoy program, they end up running the UnInstaller, which 
offers to clean up their system.    This decoy copy of UnInstaller is called a SmartDecoy.

For example, assume you are uninstalling Microsoft Excel from a network, and you've installed 
UnInstaller on C:\MHUTILS and Excel is installed on N:\EXCEL. In this case, UnInstaller deletes the 
original EXCEL.EXE and then copies itself from C:\MHUTILS\UNINSTAL.EXE to N:\EXCEL\
EXCEL.EXE.    Since this copy of UnInstaller has the same name as the original program 
(EXCEL.EXE), whenever a user tries to run Excel they will actually run the SmartDecoy copy of 
UnInstaller.    This SmartDecoy copy informs the user that the program has been uninstalled and offers 
to clean up the user's system automatically.

SmartDecoy technology is especially useful in network environments and can save a network 
administrator a large amount of time and effort.

To create a SmartDecoy
1 Select the program to be uninstalled.
2 In the "Items to be deleted" list box, make sure that the last item (Select this line to 

create a SmartDecoy) is selected.
3 Select or deselect other items in the list box as desired.
3 Choose the Uninstall button to perform the uninstall.



SmartDecoy options

If you are leaving a SmartDecoy, you can specify a message that is displayed for    all users who run 
the decoy.    This capability is provided mainly for network administrators who wish to provide an extra 
message to their users when the SmartDecoy runs.

To leave a SmartDecoy message
1 Type the message in the Message field.
2 Choose the OK button to create the decoy.

To leave no decoy message
1 Clear the text in the Message field.
2 Choose the OK button to create the decoy.

To leave no SmartDecoy
1 Choose the Cancel button.    This prevents the decoy from being created.



SmartLinks definition

UnInstaller's SmartLinks feature analyzes your system to determine which DLLs are used by which 
programs.    This allows UnInstaller to more accurately determine which DLL(s) should be removed 
when uninstalling a program.



SmartLinks

UnInstaller provides an advanced feature, called SmartLinks, which allows UnInstaller to more 
accurately determine which DLLs should be deleted when uninstalling a program.

To turn SmartLinks on
1. From the File menu, choose SmartLinks, On.

SmartLinks will scan your system and attempt to analyze which DLLs are used by which
programs.    This may take several minutes the first time that it is run.    Subsequent 
scans search only for new files on your system and usually are much faster than the 
initial scan.

To turn SmartLinks off
1. From the File menu, choose SmartLinks, Off.

If you selected a program to uninstall while SmartLinks was turned on, we recommend 
that you re-select and re-analyze the program so that SmartLinks does not affect the 
items listed for deletion.

To re-scan your whole system
1. From the File menu, choose SmartLinks, Full scan.

This will delete the data obtained from previous scans and perform a completely new 
scan.    This may take several minutes.

Technical note for developers
If you have a program that depends upon other files, embed a string (anywhere in your code) that lists 
the files required by your program.    The string should be of the form:    

      " ModList=    VBRUN100    COMMDLG    SHELL    MHUTIL    MHEN200    *" 

(The double quotes are not required.) Note that there must be one space before the word ModList, 
there must be one space before and after each module name and the last entry must be an asterisk.    
List only module names, not module filenames (ie, do not include the filename extension).    Be sure to 
list all modules called by your program, even those that are called by one of the modules that your 
program calls (ie, an indirect, or second-level, call).



Uninstall

Choose this button to begin the uninstall.

Items listed in the "Items to be deleted" list box will be deleted only if they are selected (highlighted).    
If an item is not selected, it is not deleted.

You are prompted to confirm the deletion of each item if the Confirm all deletions checkbox is checked.



Uninstall SmartDecoy

This window appears only when you are running a SmartDecoy copy of UnInstaller.    

When all users on the network have run the SmartDecoy and the administrator wants to delete the 
SmartDecoy, choose "Uninstall SmartDecoy" from the File menu for instructions.

If you are running a SmartDecoy copy of UnInstaller, you cannot use it to uninstall itself because that 
might cause a problem with Windows. 

When you want to delete the SmartDecoy, you merely have to delete a few files from the hard disk, 
using File Manager or an equivalent utility.    Choosing Uninstall SmartDecoy from the File menu 
provides instructions on which files should be deleted.



Viewer

The viewer window displays the contents of a file or a WIN.INI section.    The viewer is exactly that -- it 
is not used for editing.

If the entire file can fit in the viewer, the caption on the viewer reads "Contents of filename".
If a file is too large to fit into the viewer, the caption reads "Partial contents of filename".    

To close the viewer
1 Choose the Close button.

To copy text from the viewer to the clipboard
1 Select the text.
2 Press <Ctrl>+<Insert>> to copy the text to the clipboard.    Under Windows version 3.1 

or later you can also press <Ctrl>+<C> to copy the text.



All files with extension 'ext' on local drives (individually selectable)

Description
This is a convenient way to remove data files (documents, spreadsheets, etc.) that a program has 
created. 

When you select this item, UnInstaller scans your local hard disk(s) (but not network drives) to find all 
files ending with an extension associated with the program being removed. The files are displayed in a 
list box and you can select the ones you want to delete. 

A viewer window is provided so you can view a file before deciding whether to delete it.

Default selection
Not auto-selected.

Recommendation
Select if you would like to remove some or all of the data files that a program has created with the 
given extension.

Confirmation
Always confirmed.

See also:
UnInstaller main window



Association 'ext=Program.EXE' from WIN.INI and system 
registration database

Description
When selected, this item causes UnInstaller to remove the association from the [Extensions] section of
WIN.INI and from the system registration database. See the Associations Primer for a full explanation 
of file associations.

Default selection
Auto-selected 

Recommendation
Delete the association.

Confirmation
Depends on the state of the Confirm all deletions checkbox.

See also:
UnInstaller main window



Delete all other files in directory and its subdirectories (individually 
selectable)

Description
UnInstaller offers to delete files remaining in a program's main directory or subdirectories, after it has 
deleted the main program files and other items. UnInstaller lists all the remaining files and you can 
select individual files to be deleted.

Default selection
Auto-selected only if the directory name matches the main program name.

Recommendation
Delete the all remaining files if the only program in that directory is being uninstalled.

Confirmation
Always confirmed.

Note
This item is not listed if the program is located in your Windows or System directory or in the root 
directory of any drive.

See also:
UnInstaller main window



DLL filename.ext (is used by other programs)

DLL filename.ext (may be used by other programs)

Description
If you have enabled UnInstaller's SmartLinks feature, aany DLL(s) used by the program being 
uninstalled are listed. (DLLs are additional program files used by the main program.) It is not 
uncommon for several programs to share a DLL. If SmartLinks knows of other programs using a DLL, 
the DLL is listed in a confirmation dialog box with the notation "(is used by other programs)." If 
SmartLinks does not know of any other programs that use the DLL, the DLL is listed with the notation 
"(may be used by other programs)."

Default Selection
Not auto-selected.

Recommendation
The best strategy is to use SmartLinks, select DLLs listed for deletion, and then use the confirmation 
window to view the list of other programs which may use each DLL. You can then decide whether each
DLL should be deleted.

Confirmation
Depends on the state of the Confirm all deletions checkbox.

See also:
UnInstaller main window



Extension 'ext' from DOCUMENTS= line of WIN.INI

Description
Some programs list their document extensions on the DOCUMENTS= line of WIN.INI.

Default selection
Auto-selected.

Recommendation
Delete the extension from the DOCUMENTS= line of WIN.INI.

Confirmation
Depends on the state of the Confirm all deletions checkbox.

See also:
UnInstaller main window



File: filename.ext

Description
You can choose the "Add file..." button to specify any additional file(s) to be deleted.

Default selection
Auto-selected.

Recommendation
If you add one or more files using the Add File... button, then you probably already know that the file(s)
can be deleted.

Confirmation
Depends on the state of the Confirm all deletions checkbox.

See also:
UnInstaller main window



Help file in program directory: filename.HLP

Help file in Windows directory: filename.HLP

Help file in System directory: filename.HLP

Description
Most programs provide on-line help, contained in a file with an extension of HLP. The help file is 
usually located in the same directory as the main program file, help files can also be located in your 
Windows directory or System directory.

Default selection
Auto-selected.

Recommendation
If the program's main program file is being deleted, then delete the help file too.

Confirmation
Depends on the state of the Confirm all deletions checkbox.

See also:
UnInstaller main window



Help annotation file: filename.ANN

Description
Most programs have on-line help files to which you can add comments. These comments are stored in
a help annotation file, with an extension of ANN, and are kept in your Windows directory.

Default selection
Auto-selected.

Recommendation
If you are deleting the program's help file, then delete the help annotation file too.

Confirmation
Depends on the state of the Confirm all deletions checkbox.

See also:
UnInstaller main window



INI file in program directory: filename.INI

INI file in Windows directory: filename.INI

INI file in System directory: filename.INI

Description
Many programs store data between sessions in a file with an extension of INI. The INI file is usually 
located in the Windows directory but some programs create them in the same directory as the main 
program file or in your System directory.

Default selection
Auto-selected.

Recommendation
If you are deleting the main program file, then delete the INI file too (unless you know of another 
program on your system which also needs the same INI file).

Confirmation
Depends on the state of the Confirm all deletions checkbox.

See also:
UnInstaller main window



Main program: filename.ext

Description
Programs usually have one main file that is executed when the program is run. This is the "main 
program" file and it usually has an extension of EXE.

Default selection
Auto-selected.

Recommendation
Delete this file to remove the program from your system.

Confirmation
Depends on the state of the Confirm all deletions checkbox.

See also:
UnInstaller main window



OLE object type 'Object name'

Description
If the program is an OLE server, the objects that it can create are listed here.

Default selection
Auto-selected.

Recommendation
If you are deleting the program from your system, then you should delete the OLE object type entries 
as well.

Confirmation
Depends on the state of the Confirm all deletions checkbox.

See also:
UnInstaller main window



Program 'Program' from LOAD= line of WIN.INI

Program 'Program' from RUN= line of WIN.INI

Description
Your WIN.INI file contains two lines (LOAD= and RUN=) which you can use to specify programs that 
are automatically run when Windows starts up. These lines are commonly used to start programs such
as a clock, network utility or reminder ("tickler") programs.

Default selection
Auto-selected.

Recommendation
If you are deleting the main program file, then you should also delete its entry on the LOAD= or RUN= 
line of WIN.INI.

Confirmation
Depends on the state of the Confirm all deletions checkbox.

See also:
UnInstaller main window



Program Manager icons referencing 'Program' (with individual 
confirmation)

Program Manager icons with extension 'ext' (with individual 
confirmation)

Description
When programs are installed into your system, one or more icons are usually created in Program 
Manager to represent the program. You execute the program by double-clicking on its icon. In addition,
icons can be created to represent documents created by the program (for example, README.WRI, 
created by Write). UnInstaller can remove these icons for you.

Default selection
Auto-selected.

Recommendation
The best way to use this line is to select it and allow UnInstaller to prompt you to confirm the deletion 
of each icon individually. This strategy allows you to decide whether or not each icon should be 
deleted.

Confirmation
Always confirmed.

Note
Sometimes Program Manager does not correctly respond to UnInstaller's attempts to delete icons. If 
this happens, and UnInstaller reports that there were problems, choose the Uninstall button 
immediately after your current uninstall process finishes. Performing the uninstall immediately usually 
solves the problem.

See also:
UnInstaller main window



Remove directory (and subdirectories) if empty when done

Description
When UnInstaller is finished deleting files from the program's directory, it deletes any empty 
directories.

Default selection
Auto-selected.

Recommendation
Allow UnInstaller to remove empty subdirectories. Any directory that has files in it after the uninstall 
process is complete will not be affected.

Confirmation
Depends on the state of the Confirm all deletions checkbox.

Note
This item is not listed if you are leaving a SmartDecoy.

See also:
UnInstaller main window



Section [SectionName] of WIN.INI

Description
Many programs add sections to your WIN.INI file for the purpose of storing data between sessions. 
When uninstalling such programs, these sections of WIN.INI should be removed if they are not used 
by any other program remaining on your system.

Default selection
Not auto-selected.

Recommendation
It is difficult to determine which section belongs to which program and whether a section is shared by 
any other program. Therefore, the safest course of action is not to delete a section if you are uncertain 
if it should be deleted. 

As a precaution, you may want to create an uninstall report to make note of the section name and you 
can use IniClean later to delete the section. Alternatively, you can select the section name, and when 
you are asked for confirmation to delete the section, you can choose the View... button to display the 
contents of that section.

Confirmation
Depends on the state of the Confirm all deletions checkbox.

See also:
UnInstaller main window



Section [SPOOLER] of WIN.INI

Set 'SPOOLER=NO' in WIN.INI

Description
If you are uninstalling the Windows Print Manager, these two items are presented to allow you to 
remove Print Manager's settings from your WIN.INI file.

Default selection
Auto-selected.

Recommendation
If you are uninstalling Print Manager, you should allow UnInstaller to make these changes.

Confirmation
Depends on the state of the Confirm all deletions checkbox.

See also:
UnInstaller main window



Select this line to create a SmartDecoy

Description
If you wish to create a SmartDecoy of the program that you are uninstalling, select this item. See the 
SmartDecoy primer for a full explanation of SmartDecoys.

Default selection
Not auto-selected.

Recommendation
If you are uninstalling a program that is located on a network, and the program is used by other users 
on the network, we recommend that you create a SmartDecoy.

Confirmation
Always confirmed.

Note
This item is slightly different from most of the other items because selecting it does not actually delete 
anything. Instead, it enables the creation of a SmartDecoy.

See also:
UnInstaller main window



Select this line to create an uninstall report

Description
UnInstaller can create a report that lists which items were deleted and which items were not deleted. 
Select this line to create the uninstall report.

Default selection
This item is not selected by default. Once selected it remains selected until you deselect it or until you 
exit UnInstaller.

Recommendation
We recommend that you allow UnInstaller to create an uninstall report. The default settings keep a 
running report of UnInstaller's activities in a disk file.

Confirmation
The Confirm all deletions checkbox has no effect on the uninstall report.

Note
This item is slightly different from most of the other items because selecting it does not actually delete 
anything. Instead, it enables the creation of an uninstall report.

See also:
UnInstaller main window




